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Chapter 1
Introduction
The Get.It! Base Installation and Administration Guide includes instructions 
for installing and configuring Get.It! Base. The guide also describes the 
administrative steps you can take to monitor the server connections, perform 
user administration, change control settings, and set up NT Challenge and 
Response security features.

With Get.It! Base, you can create Web pages that give users access to back-end 
systems on the corporate intranet via Web browsers. Users can then perform 
tasks like opening problem tickets, requesting office equipment, or keeping 
track of computers that have been ordered.

About this Manual
The Get.It! Base Installation and Administration Guide is used with several 
other manuals, which are:

• Operating guides, reference manuals, and other documentation for your PC 
hardware and operating software.

• The Get.It! Base Tailoring Guide which describes how to customize Get.It! 
Base to suit your needs. It also describes the basic architecture on top of 
which Get.It! Base is programmed.

• JRun documentation located online in the ...JRun\docs directory

To use this manual effectively, you should have a working knowledge of both 
the PC hardware and operating software, and of the database management for 
the back-end systems you are linking to Get.It! Base (such as Peregrine’s 
ServiceCenter and AssetCenter). 

Note: If you will be using Get.It! Base to create a Web interface to 
ServiceCenter or AssetCenter, refer to the ServiceCenter or 
AssetCenter manuals for instructions on installing and using these 
systems.
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Organization of the Manual

This manual is organized around the main functions associated with the 
installation and administration of Get.It! Base. The following table shows you 
which parts of the manual you need to reference to find the information you 
need. 

To Find This Look Here

Background information; how to use this 
manual.

Chapter 1: Introduction

Procedures for installing Get.It! Base. Chapter 2: Windows NT 
Installation Procedures

Resetting the server link to the back-end 
systems; monitoring the server log; setting 
controls in the archway.ini file.

Chapter 3: Get.It! Base 
Administration Module

Information regarding user IDs; registering 
users.

Chapter 4: User Administration

Setting up NT Challenge and Response; 
setting permissions for file access; testing the 
setup of NT Challenge and Response.

Chapter 5: NT Challenge and 
Response

Using the File Attachment utility to attach 
files to Web pages.

Chapter 6: File Attachment

Verifying the connections to AssetCenter and 
ServiceCenter. Troubleshooting the JRun 
configuration. Ensuring the IIS configuration 
is set correctly.

Chapter 7: Troubleshooting
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Conventions Used in this Manual

The following documentation conventions are used in this guide:

What’s on the CD
The CD contains the following items required in the operation of Get.It! Base:

• Administration and tailoring tools for Get.It! Base. 

• Current ServiceCenter and AssetCenter DLLs. These must be used to 
successfully integrate with ServiceCenter and AssetCenter.

Note: Get.It! Base must be installed on the same machine as the IIS Web 
server. The Web server may be on a different machine than the back-
end servers (ServiceCenter and AssetCenter).

• A copy of Allaire JRUN 2.3.3. This software is installed during the Get.It! 
Base installation.

Object Font Example

Button Bold Click Next.

Directory path/file name Courier New C:\Program Files\getit\

login.asp

... Courier New var msgTicket = new Message( "Problem" );

...
msgTicket.set( "_event", "epmc" ); 

The ellipsis (...) is used to indicate that portions of 
a script have been omitted because they are not 
needed for the current topic. Samples of code are not 
entire files, but they are representative of the 
information being discussed in a particular section.

AssetCenter is not 
available for Solaris.
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Installing the Back-end Systems
If you are going to use Get.It! Base to connect to ServiceCenter or AssetCenter, 
you will need to install these products first. The back-end systems are not 
included on the Get.It! Base CD. The installation instructions for those sys-
tems can be found in their respective system manuals.
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Chapter 2
Windows NT Installation Procedures
This chapter leads you in the installation and configuration of Get.It! Base. 
There are three phases to the installation process: 

• File Installation from CD-ROM

• Server (IIS/PWS) Configuration for Get.It! Base.

• ServiceCenter and AssetCenter configuration.

Windows Installation Requirements
This section outlines the recommended minimum configuration for proper 
installation and configuration of Get.It! Base on a Windows NT server. Before 
beginning the installation of Get.It! Base, ensure that you have the following. 

Software

• Microsoft Windows NT 4.0 Server or Workstation, or Windows 2000. 

• Microsoft IIS Server - 4.0 (available from the Microsoft Web site)

Note: The Windows NT Workstation supports the Personal Web Server 
application instead of the Internet Information Server, which only runs 
on the Windows NT Server. Windows NT Server will be required for a 
production environment due to Microsoft licensing constraints.

• If you will be using the AssetCenter templates, you need access to 
Peregrine’s AssetCenter, version 3.02 or later. The AssetCenter API must 
be installed on the same system as Get.It! Base; however, the AssetCenter 
database can be on another system. This means that when you install 
AssetCenter, you must either proceed with: (1) a full installation, or (2) a 
custom installation, selecting the “AssetCenter API” option. AssetCenter 
must be installed and have a valid connection established to the database 
on the Get.It! Base server. Get.It! Base uses the amdb.ini file to determine 
how to attach to the AssetCenter database.
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• If you will be using Get.It! Base with Peregrine’s ServiceCenter, you must 
have ServiceCenter 3.0 SP3 or later installed.

Hardware

• Pentium 400mhz or faster with at least 256MB of RAM.

• Approximate Disk space - 100MB.

Prerequisites
To have a successful and easy installation, you will need the following infor-
mation:

• Do you have JRun installed? If so, is it version 2.3.3? If it is a version less 
than 2.3.3, uninstall the earlier version before you start the Get.It! Base 
installation, or you can uninstall the older version of JRun and install the 
newer version as part of the Get.It! Base installation process.

• You will need a JRun license key and, if you are using the AssetCenter 
templates, an AssetCenter Authorization code. If you have not already 
received these, call Peregrine’s Customer Support or your Account 
Representative.

• What is your IIS “scripts” directory? The default is usually 
“C:\InetPub\scripts.”

• If you do not want to install Get.It! Base into the default folders, you need 
to know the destination folders into which you want to install it. These 
folders are referred to frequently in the Get.It! Base Tailoring Guide. If you 
choose to use different folders, you need to let the users who will be 
tailoring Get.It! Base know where you put the files.
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Installing Get.It! Base
To install Get.It! Base:

1. Insert the Get.It! Base CD into your CD-ROM drive. If the setup does not 
automatically begin, use the Run command from the Windows Start 
menu. Run setup.exe from the CD ROM drive. 

2. Install Shield begins and the Welcome dialog box is displayed. Click Next.

3. When presented with the Software License Agreement dialog box, read 
the agreement conditions.

4. When ready, click Yes to accept the terms and continue with the 
installation.

Before you begin the 
installation, make 
sure you have 
completed all of the 
items listed in 
”Prerequisites” on 
page 2-2.

The drive you specify 
should be the CD 
ROM drive where the 
Get.It! Base CD is 
loaded.

Fig. 2.1 Typing the install command

If you experience 
errors during the 
installation, refer to 
Troubleshooting on 
page 7-1 for 
information on 
manual installation 
procedures.

Fig. 2.2 Selecting the components to install
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5. Select which of the available components to install: 

• Get.It! Base

• AssetCenter Templates—You must have AssetCenter installed to use these 
templates. 

• Configure Multiple VMs—If the server has multiple processors, check this 
option. After completing the Get.It! Base installation, make sure you follow 
the procedures on page 2-18 for configuring multiple virtual directories.

Click Next.

The Select Program Folder dialog box is displayed.

6. You can use the default program folder for your installation, or you can 
type another name or choose one from the list. Make your selection, and 
then click Next.

A prompt is displayed, indicating that Setup must stop the IIS Admin 
Service and JRun Service Manager before installing Get.It! Base.

7. Click Yes.

Fig. 2.3 Select Program Folder

Fig. 2.4 Stopping the IIS and JRun Services
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The IIS and JRun servers will be stopped so that the installation can 
continue. When the servers are stopped, the Get.It! Base files are installed 
onto your system. 

After the Get.It! Base files have been copied to your system, the Select Compo-
nents dialog box is displayed. Go to the next section, “Installing JRun,” to con-
tinue your Get.It! Base installation.

Installing JRun

The next phase of the installation depends on whether you have JRun already 
installed. You can either keep an existing installation or install JRun. 

To Keep an Existing JRun Installation

If you already have JRun installed and want to keep the existing version, use 
the following procedure. 

1. In the Select Components dialog box, click to “keep the existing version.” 
Click Next.

A dialog box is displayed in which you can specify the location of your 
current JRun installation. The default location is C:\JRun.

Fig. 2.5 Select to keep the existing JRun version
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2. Verify the location, or browse to the correct location. Click Next.

A prompt is displayed indicating that the installation is being completed. 
When the installation is finished, a prompt is displayed indicating that 
the installation was successful. Click OK.

To Install JRun

If you do not have JRun installed, use the following procedure.

Fig. 2.6 Path to the current installation of JRun

Fig. 2.7 Select to install JRun
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1. In the Select Components dialog box, verify that the option to install JRun 
is selected. Click Next. 

A dialog box is displayed in which you can select the folder where you 
want JRun installed. We recommend that you install JRun into the 
default directory (C:\JRun).

2. Click Next.

JRun is installed into the folder you specified. When the installation is 
complete, the Setup Wizard starts.

Go to the next section, “Using the JRun Setup Wizard,” to complete your 
Get.It! Base installation.

We recommend you 
install JRun into the 
default directory. 

Make note of the 
directory you enter 
here. You will need to 
enter this directory 
later in the installation 
process.

Fig. 2.8 Choosing the destination directory for JRun
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Using the JRun Setup Wizard

The JRun Setup Wizard starts automatically.

1. Click Next to enter the setup wizard.

Fig. 2.9 The JRun wizard
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2. The first prompt requests the JRun root directory. This is the directory 
where you installed the JRun application. Enter the JRun root directory 
and click Next.

3. A window is displayed that mentions migrating property settings. Leave 
this blank and click Next. 

4. A JSM license key is required by Get.It! Base. You should have received 
this information from Peregrine Customer Support or your Account 
Representative. Enter the license key and click Next.

5. Do not enable CF Anywhere. Click Next.

Fig. 2.10 Entering the JRun root directory
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6. Select Map *.jsp to JSP 1.0, and click Next.

7. Select ISS/PWS 3.0/4.0, and click Next.

Important: The 
default for this 
window is the wrong 
option. You must click 
on the “Map *.jsp to 
JSP 1.0” option.

Fig. 2.11 Mapping *.jsp to JSP 1.0

There is no default 
given for this 
window. You must 
click on the 
“IIS/PWS 3.0/4.0” 
option.

Fig. 2.12 Selecting the correct connector
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8. Accept the default settings for the Proxy Host and Proxy Port in the next 
prompt, and click Next.

.

9. When presented with the prompt requesting the IIS ‘\scripts’ directory, 
type in the path to the InetPub\scripts directory (by default at the base 
C:\ level. So you would type C:\Inetpub\scripts.). Click Next

The following confirmation prompt should appear:

10. Click OK.

11. You should see a message telling you the Connection Configuration was 
successful. Click Finish.

12. A window is displayed which allows you to display the JRun Release 
Notes. Click Yes to see the release notes or No to continue with the Get.It! 
Base Installation. 

Leave the JRun 
Global filter active.

However, if you 
selected the option 
“Configure Multiple 
VMs” during the 
installation, 
deselect this box.

Fig. 2.13 Entering the jscripts directory

It is important that you get 
this confirmation. If you do 
not, it means that JRun did 
not install properly. This 
could be due to a server 
not being stopped. 

Fig. 2.14 JRun confirmation prompt
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If you selected to configure multiple virtual machines, the following dialog 
box is displayed.

13. Enter the number of virtual machines, and then click Next. 

14. An Information dialog box is displayed when the installation is finished. 
Click OK. 

15. Restart your computer.

The Get.It! Base files are now loaded on the server; however, several steps 
remain before Get.It! Base can be used.

If you are going to use the AssetCenter templates and have not already 
installed AssetCenter, you may wish to install an AssetCenter client on the 
server where you installed Get.It! Base to verify connectivity to AssetCenter. 
The AssetCenter API must be installed during the installation. See “Software” 
on page 2-1 for more information about the AssetCenter API.

The sections that follow include descriptions of the following:

• Configuration of the Microsoft Internet Information Server

• Configuration of the Microsoft Personal Web Server

• Installation verification process

• ServiceCenter configuration process

• Configuration of AssetCenter database

Proceed through these sections to fully install and configure Get.It! Base.

Fig. 2.15 Configuring multiple virtual machines

You will see this 
dialog box only if you 
indicated that you 
were configuring 
multiple virtual 
machines. 
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Windows NT Configuration
This section provides details on the creation of a new virtual directory for 
Get.It! Base operations. You will need to configure a virtual directory for each 
virtual machine you had configured during the Get.It! Base installation pro-
cess.

Depending on whether you are running Get.It! Base on a Windows NT Work-
station or a Windows NT Server, the configuration of the Microsoft web 
administration server differs. 

• Windows NT Workstations only run the Personal Web Server (PWS) 
application

• Windows NT Servers only run the Internet Information Server (IIS). 

This section provides detailed instruction on the configuration of both the Per-
sonal Web Server and Internet Information Server.

Personal Web Server Configuration

1. From the Start menu, open Programs>Windows NT Options Pack>
Microsoft Personal Web Server, and select Personal Web Manager.

Fig. 2.16 Displaying the Personal Web Manager
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The Personal Web Manager window is displayed.

2. Click the Advanced icon on the lower left side of the window.

The Advanced Options screen is displayed with a listing of all current virtual 
directories under the Home (root) directory.

Fig. 2.17 The Personal Web Manager
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3. Right-click on the Home directory, and select Add virtual directory.

4. Use Browse to locate or enter the path where Get.It! Base was installed. 
By default it is installed in Program Files\getit\presentation. Enter getit 
for the Alias value. Check to activate the Execute Access option. Click 
OK.

You are returned to the Advanced Options window. 

5. In the Advanced Options window, check to activate the Allow Directory 
Browsing option. Click the Main icon in the upper left part of the 
window. Click Start to start the Personal Web Server.

Fig. 2.18 Using the Advanced Options

We recommend you 
call the virtual directory 
getit.

Make sure all three 
Access options are 
checked.

Fig. 2.19 Creating the getit virtual directory
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Internet Information Server (IIS) Configuration

1. Start the Microsoft Internet Service Manager from the Start menu.

2. From the IIS desktop, right-click on the Default Web Site and select New> 
Virtual Directory. The New Virtual Directory Wizard starts, prompting 
you for the alias of the directory.

3. If, during the installation process, you configured multiple virtual 
machines, you need to create a virtual directory for each machine. If you 
did not configure multiple machines, create one virtual directory.

Fig. 2.20 Starting the New Virtual Directory wizard
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4. If you are creating just one virtual directory, call it getit. If you need to 
create multiple virtual directories, use the format getit_vm(n) where (n) 
is a sequential number you assign. So the first directory you create would 
be getit_vm1, the second would be getit_vm2, and so forth. Click Next.

5. This dialog box asks for the path to the directory containing the material 
to be published. Enter the physical path for the Get.It! Base directory. The 
default path is C:\Program Files\getit\presentation.

Fig. 2.21 Naming the virtual directory

Fig. 2.22 Mapping the virtual directory
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6. Select all check boxes to set the permissions. Click Finish. The 
configuration and setup of the Microsoft IIS or PWS is now complete.

7. Repeat this process until you have created all necessary virtual 
directories. 

Configuring Multiple Virtual Directories

If you have just created multiple virtual directories, use the instructions in 
this section to configure them. If you created one virtual directory you can 
skip these instructions.

1. Start the Microsoft Internet Service Manager from the Start menu.

2. Right-click the first virtual directory you just created and select 
Properties.

Fig. 2.23 Setting permissions for the virtual directory
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3. In the Application Settings area of the window you should see the virtual 
directory you selected in the Name field. Click Configuration.

4. The Application Configuration window is displayed. Click Add.

5. Enter C:\JRun\jsm-vm*\jrun.dll in the Executable field and JSP in the 
Extension field. Click OK.

6. Repeat this process for each virtual directory you created.

Fig. 2.24 Setting properties for virtual directories

Fig. 2.25 Configuring virtual directories
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7. When you have configured all virtual machines, reboot the server. 

When you reboot, there should be a JRun gear icon shown in the taskbar for 
each virtual machine. The first virtual machine is called JRun Service Man-
ager. Other virtual machines are stored in the ...\JRun\ directory in a file 
named jsm-vm(n) where (n) is a sequential number assigned to each virtual 
machine. An NT service is installed with the name JRun JVM(n). If you dou-
ble-click on a gear icon, the JRun manager will be displayed and you will see 
the name of the virtual machine at the top of the window. You can also see the 
services by using the NT Services administration tool. 
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Configuring ServiceCenter 
and AssetCenter

If you are using Get.It! Base with ServiceCenter or AssetCenter, unique con-
figuration steps must be performed to use the functionality of these external 
systems. This configuration is detailed in this chapter.

ServiceCenter Configuration

The configuration steps involved for ServiceCenter include:

• Loading the ServiceCenter data unload files.

• Running the *aapm.global.initer system command.

• Running the *aapm.server.initer system command.

• Stopping and starting the ServiceCenter console.

ServiceCenter formatted unload files are included with the installation of 
Get.It! Base and need to be loaded onto your ServiceCenter system. The files 
you will load are state.unl and portal.unl. If you will be using Service-
Center and want your stateless data to be stored in ServiceCenter instead of 
your browser’s cookie, you must unload the state.unl file.

The following procedure shows how to unload the portal.unl file. Repeat the 
procedure if you also want to load the state.unl file.

Note: A file named qman.unl is also included. However, this file is reserved 
for future use and you do not need to unload this file.

1. Verify that the ServiceCenter server is running.

2. Open a full (system) ServiceCenter client and log into the system as an 
administrator.

3. On the Toolkit tab, click Database Manager.
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4. Pull down the Options menu and select Import/Load.

Fig. 2.26 Importing the files into ServiceCenter
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5. Enter the full file name and path where you installed the Get.It! Base 
files. For example, the default location for the ServiceCenter portal.unl 
file is:

...\getit\config\ServiceCenter\portal.unl

6. Click Load fg.

You are returned to the Database Manager dialog box with a message in 
the status bar indicating that the file has been loaded.

7. Use the M button to display the other messages generated during the 
load.

8. Repeat steps 4-7 for each file you need to load.

9. Click Back to return to the home menu.

10. Click Command, to open a command prompt.

11. Type *aapm.global.initer, and press ENTER.

12. Type *aapm.server.initer, and press ENTER.

13. Click Back, and log out of the client.

14. Stop the ServiceCenter console.

15. Restart the ServiceCenter console.

Fig. 2.27 Loading the files into ServiceCenter
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AssetCenter Configuration

Before you can use Get.It! Base with AssetCenter, you must establish user 
login IDs in AssetCenter. Refer to your AssetCenter documentation for 
instructions on creating login IDs.

If you have installed AssetCenter for the first time, in order to use Get.It! 
Base, you need to log in and enter your AssetCenter authorization code. 

Note: If you do not enter an authorization code, Get.It! Base will not be able 
to access AssetCenter. The DLL connection fails if an Authorization 
Code has not already been given for AssetCenter.

If Get.It! Base and AssetCenter are installed on different servers, use the 
Get.It! Base Administration module to update the Archway.ini file to include 
the correct AssetCenter connection. 

Verifying the Installation
After you have completed the installation and configuration steps, use the 
Get.It! Base Administration module to verify the server connections and to 
ensure the controls are set as you want them.

Below are brief instructions for accessing and checking the installation using 
the Get.It! Base Administration module. For detailed instructions, see Chap-
ter 3, "Get.It! Base Administration Module." 

1. To begin using Get.It! Base, verify that the IIS or PWS and JRun servers 
are started and, if you are using ServiceCenter, that the ServiceCenter 
server is running.

2. Open a browser window and enter the following URL: http://webserver/
getit/admin.jsp (where webserver is the name of your web server, and 
getit is the virtual directory name.)

See “Windows NT Configuration” on page 2-13 for details about setting up a 
virtual directory. 

3. Press Enter.

4. The first time you access the Administration module, you are asked to set 
up the administrator’s ID and password. Enter the information and click 
Logon as Administrator. If you are not ready to set up the 
Administrator’s ID and password, click Logon as Administrator 
without entering any information. 

If you are using 
Oracle as your 
AssetCenter 
repository you should 
have both a User 
DSN entry and a 
System DSN entry.
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5. The first screen you see shows the connections between Get.It! Base and 
ServiceCenter and AssetCenter. Make sure the status is connected. You 
can click Reset Server, if needed.

6. On the left side of the window are two options: Server Log and Settings. 
Click on Settings.

7. The settings from the Archway.ini file are shown in the window. You can 
update all file settings here. Each setting is described on the screen. We 
recommend you verify all settings, especially the AssetCenter Adapter 
Settings and ServiceCenter Adapter Settings (scroll down to see them). 
Windows NT Installation Procedures 2-25





Chapter 3
Get.It! Base Administration Module
Get.It! Base provides you with an Administration module which you can use 
to monitor how Get.It! Base is working and to change the control options in 
the Archway.ini file. This makes it easy for you to monitor and troubleshoot 
connections between the databases you are using and Get.It! Base.

You can use the Administration module to add adapters to connect Get.It! 
Base to additional databases.

Using the Administration Module
The Get.It! Base Administration module allows you to:

• Monitor the connection between the Get.It! Base server and the back-end 
servers

• View the server log, which shows all activity on the Get.It! Base server

• View and change the settings in the Archway.ini file

• Start and stop various JScript functions using Show Script Status

• Show Message Queuing to view queue contents

• Use Queue Status to view all queues

To begin using the Get.It! Base Administration module:

8. Verify that the IIS or PWS and JRun servers are started.

9. Open a browser window.

10. Enter the following URL: http://webserver/getit/admin.jsp in the 
browser address field, where webserver is the name of your Web server 
and getit is the virtual directory name.

The first time you access the Administration module through admin.jsp, you 
are asked to set up the administrator’s ID and password. Enter the informa-
tion and click Logon as Administrator. If you have not yet entered an 
Administrator’s ID and password, you can just click Logon as Administra-
tor without entering any information. 
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If you enter using the Admin button after logging in to Get.It! Base, you are 
linked directly to the Control panel.

Using the Control Panel

When you first log in, the Control Panel window is displayed. 

Use this window to check the status of the connections to the databases you 
are accessing with Get.It! Base. You can also reset the server, if necessary, by 
clicking Reset Server. 

There are five activities available from this window:

• Click Server Log to view activity on the Get.It! Base server. 

• Click Settings to view and change the settings in the Archway.ini file. If 
the back-end system is loaded on a server different from Get.It! Base, 
update the Archway.ini file to reflect the appropriate connection name and 
the Administrator’s user name and password. 

• Click Show Script Status to see which scripts are running. You can start 
and stop scripts from this window.

• Click Show Message Queues to see a list of all message queues. Click on 
the queue name to see the contents of the queue.

Fig. 3.1 Administration Module Control Panel
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• Click Show Queue Status to see the current status of the queues, 
operational and unlocked, or suspended. Click Toggle Queue Operations 
to change the status of the queues.

Viewing the Server Log

The Server Log provides the history of the server. You can choose the number 
of lines to make available when scrolling down the screen. Click Reset to clear 
the log, or Refresh to update.

Archway.ini Settings

Click Settings to display the current settings in the Archway.ini file. This file 
allows you to control items such as:

• General Execution Options (debug logging and scripting, session time-out, 
and adapters, language and currency settings)

• Weblication Settings

Fig. 3.2 Administration Module Server Log
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• Adapter Settings

• Email Settings

• Advanced Settings (tracking options and event queue)

Each available option is explained on the screen. See Figure 3.3, below.

The stdout flag controls whether the log will be written to the standard out-
put in addition to being written in the specified archway log file (controlled by 
the LogFile parameter in archway.ini). The standard output for JRun is the 
stdout.log file you can find in your ...JRun\jsm-default\logs folder. 

Fig. 3.3 Administration Module Settings
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Archway.ini Parameters
The following table lists the archway.ini parameters and gives a description 
of each. The default settings are shown after the equal sign (=) for each 
parameter. You will need to edit the archway.ini file to change many of these 
parameters.

Note: Some of these parameters are specific to AssetCenter and 
ServiceCenter and do not apply if you are not using these products.

Parameter Description

debugforceddeclarations=false Set this to true to generate log information useful 
when troubleshooting the server. 

defaultcapabilities=portalDB
(getit.portal)

Semicolon separated list of access rights that all 
users should have regardless of their profile. 
Access rights are assigned to Target adapters in 
the following way:
portalDB(getit.portal)

scriptpollers=false Select to enable script processing. Normally, this 
should be set to true. A setting of false will stop 
your server from performing background tasks. 

images=images/ Set the Skins directory location. The directory 
name must be specified relative to the 
’presentation’ directory. Setting this allows you to 
move the default location of the skins directory to 
another location. 

adapters=ac=ACAdapter;
portalDB=ACAdapter

Semicolon separated list of Target and Adapter 
assignments supported by Archway.

cookieexpiration=2592000 Number of seconds to store Weblication user 
settings as browser cookies. For instance, a user’s 
name and password is remembered by a 
weblication by storing it in a cookie. 

acadminpassword= Administration password used by Get.It! Base 
when performing tasks such as user 
authentication and registration in AssetCenter.

mailpassword= User password used to access the mail server. 

mailuser= User name used to access the mail server. 

schost=localhost Host name of the ServiceCenter server. 
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logfile=c:\program 
files\getit\archway.log

The full directory path to the file used for logging. 

mailsender= Reply address used when sending email. 

maxscriptrunners=10 Maximum number of script execution threads. 
The default is 10. 

adminname= Administration user used to log in to the 
Admin.jsp page.

resolveappstrings=false Set to true if you want to resolve any application 
strings.

logo=images/logos/
logo_getit_green.gif

Set the logo to be used in the application. The path 
must be relative to the presentation directory. 

sclog=d:\program 
files\getit\sc.log

Path to SC logging used by the ServiceCenter 
client connection. 

ns_css=ns_css/ Directory path for CSS stylesheets directory for 
Netscape Navigator browsers.

scadmin=falcon Administration user used by Get.It! Base when 
performing tasks such as user authentication and 
registration in ServiceCenter.

mailhost= Mail server host used by Get.It! Base to send e-
mail messages. 

skins=skins/ Set the Skins directory location. The directory 
name must be specified relative to the 
...\presentation\images\ directory. Setting 
this allows you to move the default location of the 
skins directory to another location. The default is 
...\skins. 

debuglog=true Generates log information useful when 
troubleshooting the server. 

currency=USD Comma-separated list of ISO-4217 currency codes 
that define which currencies will be used in a 
given installation. The first code defines the 
default currency to use when a currency type is 
not specified. For example, USD,EUR defines US 
Dollars and European Euros as supported 
currencies. 

acanonymouspassword= Anonymous user password for AssetCenter.

scanonymouspassword= Anonymous user password for ServiceCenter.

Parameter Description
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weblication=getit.xml The default weblication file.

scripttimeout=0 Number of milliseconds to allow an inactive 
session to exist before autologout. 

stylesheet=classic.css Set the CSS Stylesheet name for user sessions. 
The default is "classic.css". 

logstdout=false Normally set to false. Enables logging to 
...\jrun\jsm-default\logs\stdout.log.

displayforminfo=false When set to true, form information is displayed in 
each screen to aid during weblication development 
and customization. 

maildomains=peregrine.com;
apsydev.com;getmarketaccess.
com

A semicolon-separated list of mail domains that 
Get.It!Base can correspond with. Only users with 
an e-mail address in these domains are allowed to 
complete online self-registration. 

qmanstorageadapter=ac AssetCenter B2B adapter.

acdatabase=acdemo351eng Name of AssetCenter database. 

derivedscriptpath= Source script directory.

acanonymous=Admin Anonymous user name for AssetCenter. 

scanonymous=falcon Anonymous user name used when an unknown 
user attempts to communicate with ServiceCenter 

acdateformat=yyyy-MM-dd AssetCenter date format.

adminpassword= Administration password for Admin.jsp page.

debugscript=true When enabled, scripts and schemas are reparsed 
each time they are invoked. Be sure to turn this off 
in a production system. 

maxlogsize=1000000 Enter maximum size for the log file in bytes. 

sessiontimeout=6000000 Number of milliseconds to allow an inactive 
session to exist before autologout.

statestorage=StateMemory Memory, fastest choice but depends on continuous 
service from one Web Server. 

sclog The location of the sclog file. The default is 
C:\Program Files\getit\sc.log.

scport=12670 Port number of ServiceCenter server.

Parameter Description
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locale=en Comma-separated list of supported locales that 
define the languages available and locale specific 
variations based on a user’s country. A user’s 
browser can be configured to display a specific 
language and format dates and currency based on 
a certain country’s conventions. The first locale 
defines the default used. A locale is specified by 
combining the ISO-639 language code and 
optionally with the ISO-3166 Country code 
separated with an underline. For example, "en" or 
"fr" can be specified for English or French support, 
whereas "en_US" and "en_GB" can further refine 
the locale so that dates are formatted Mon/Day/
Year in the United States and Day/Mon/Year in 
Great Britain. The value en,fr,de,it specifies 
that English, French, German, and Italian are all 
supported in a given installation. 

defaultskin=classic The default skin that is used when a user first logs 
into Get.It! Base. If you change the default to 
another style then this style will be recorded in a 
database as well as in the browser’s cookie.

defaultstylesheet=classic The default stylesheet that is used when a user 
first logs into Get.It! Base. If you change the 
default to another style, this style will be recorded 
in a database as well as in the browser’s cookie.

scadminpassword= Anonymous user password for ServiceCenter.

ie_css=css/ Directory path for CSS stylesheet direcotry for 
Inernet Explorer.

acadmin=Admin Administration user name for AssetCenter.

acapidll Used with AssetCenter version 3.5 and above. 
This parameter is not mandatory because Get.It! 
Base can detect and load the correct DLL based on 
the connection name defined the the acdatabase 
parameter. When this parameter is not specified 
Get.It! Base uses the information provided by 
AssetCenter in the connection description 
(amdb.ini) to determine the DLL name. Use this 
parameter only if the default name determination 
does not work.

Parameter Description
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acapidllpath Gives the path to the folder in which the 
AssetCenter API DLL is located. If this paramter 
remains blank, Get.It! Base searches those folders 
in which AssetCenter is installed for a DLL with 
the expected name. If the requested DLL is not 
located, Get.It! Base will load it from its bin 
folder. This parameter should be used only if the 
default path determination does not work as 
expected. Note that in the case where the locale 
parameter in archway.ini contains “ja” (meaning 
that you intend to use Japanese), Get.It! will only 
load the API DLL from an AssetCenter Japanese 
folder, and if it does not find it there it will load it 
from ...\bin\ja\.

acdefaultloginclass Establishes the type of default user login.This 
parameter can have four different values. If it is 
empty or not specified in archway.ini then self-
registered users are added to AssetCenter with 
the default login class defined in AssetCenter. Out 
of the box, the default for a registered user in 
AssetCenter is named user. If the value is casual, 
(acdefaultloginclass=casual) the self-
registered user will be added as a floating user. If 
the value is floating, 
(acdefaultloginclass=floating) the self-
registered user will be added as a floating user. If 
the value is named, 
(acdefaultloginclass=named) the self-
registered user will be added as a named user. 
Casual, floating, and named user are each 
described in the AssetCenter documentation.

jrunroot=c:\Jrun\ The root JRun directory; default for installation.

appspath=apps/ The root directory for the Get.It! Base application.

ACProfilePool= This adapter consists of a database connection 
pool that allows the ACAdapter to combine users 
of the same profile into using the same connection. 
This quickens the process because the 
AmSUImpersonate call does not proceed with the 
login procedure when a user’s profile is the same 
as the last impersonated user. 

Parameter Description
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ISO Chart for Locale and Currency

The following chart shows the ISO codes to use in the “Locale” and “Curren-
cies” fields in the Settings. All languages and currencies are not currently 
available. Check your latest Release Notes for the supported languages. 

Language
Language 
Code Country

Country 
Code Currency

Currency 
Code

Albanian sq Albania AL Lek  ALL

Arabic ar United Arab 
Emirates

AE Dirham  AED

ar Bahrain BH Dinar  BHD

Arabic ar Algeria DZ Algerian 
Dinar

 DZD

ar Egypt EG Pound  EGP

ar Jordan JO Dinar  JOD

ar Kuwait KW Dinar  KWD

ar Lebanon LB Pound  LBP

ar Libya LY Dinar  LYD

ar Morocco MA Dirham  MAD

ar Oman OM Sul Rial  OMR

ar Qatar QA Rial  QAR

ar Saudi 
Arabia

SA Riyal  SAR

ar Sudan SD Dinar  SDD

ar Syria SY Pound  SYP

ar Tunisia TN Dinar  TND

ar Yemen YE Rial  YER

Bulgarian bg Bulgaria BG Lev  BGL

Byelorussian be Belarus BY Ruble  BYR

Catalan ca Spain ES Peseta  ESP
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Chinese zh China CN Yuan 
Renminbi

 CNY

zh Hong Kong HK Dollar  HKD

zh Taiwan TW Dollar  TWD

Croatian hr Croatia 
(Hrvatska)

HR Kuna  HRK

Czech cs Czech 
Republic

CZ Koruna  CSK

Danish da Denmark DK Krone  DKK

Dutch nl Belgium BE Franc  BEF

nl Belgium BE Euro  EUR

nl Netherlands NL Euro  EUR

Dutch nl Netherlands NL Guilder  NLG

English en Australia AU Australian 
Dollar

 AUD

en Canada CA Dollar  CAD

en Ireland IE Euro  EUR

en Great 
Britain (UK)

GB Pound 
Sterling

 GBP

en Ireland IE Punt  IEP

en New 
Zealand 
(Aotearoa)

NZ Dollar  NZD

en United 
States

US US Dollar  USD

en South Africa ZA Rand  ZAR

Estonian et Estonia EE Kroon  EEK

Finnish fi Finland FI Euro  EUR

fi Finland FI Markka  FIM

Language
Language 
Code Country

Country 
Code Currency

Currency 
Code
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French fr Belgium BE Franc  BEF

fr Canada CA Dollar  CAD

fr Switzerland CH Franc  CHF

fr Belgium BE Euro  EUR

fr France FR Euro  EUR

fr Luxembourg LU Euro  EUR

fr France FR Franc  FRF

fr Luxembourg LU Franc  LUF

German de Austria AT Schilling  ATS

de Switzerland CH Franc  CHF

de Germany DE Deutsche 
Mark

 DEM

de Austria AT Euro  EUR

de Germany DE Euro  EUR

German de Luxembourg LU Euro  EUR

de Luxembourg LU Franc  LUF

Greek el Greece GR Drachma  GRD

Hebrew iw Israel IL Shekel  ILS

Hungarian hu Hungary HU Forint  HUF

Icelandic is Iceland IS Krona  ISK

Italian it Switzerland CH Franc  CHF

it Italy IT Euro  EUR

it Italy IT Lira  ITL

Japanese ja Japan JP Yen  JPY

Korean ko Korea 
(South)

KR Won  KRW

Latvian lv Latvia LV Lat  LVL

Lithuanian lt Lithuania LT Lita  LTL

Language
Language 
Code Country

Country 
Code Currency

Currency 
Code
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Macedonian mk Macedonia MK Denar  MKD

Norwegian no Norway NO Krone  NOK

Polish pl Poland PL Zloty  PLZ

Portuguese pt Brazil BR Brazilian 
Real

 BRR

pt Portugal PT Euro  EUR

pt Portugal PT Escudo  PTE

Romanian ro Romania RO Leu  ROL

Russian ru Russian 
Federation

RU Ruble  RUR

Serbian sr Yugoslavia YU New Dinar  YUN

Serbo-
Croatian

sh Yugoslavia YU New Dinar  YUN

Slovak sk Slovak 
Republic

SK Koruna  SKK

Slovenian sl Slovenia SI Tolar  SIT

Spanish es Argentina AR Peso  ARP

Language
Language 
Code Country

Country 
Code Currency

Currency 
Code
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Spanish es Bolivia BO Boliviano  BOB

es Chile CL Peso  CLP

es Colombia CO Peso  COP

es Costa Rica CR Colon  CRC

es Dominican 
Republic

DO Peso  DOP

es Ecuador EC Sucre  ECS

es Spain ES Peseta  ESP

es Spain ES Euro  EUR

es Guatemala GT Quetzal  GTQ

es Honduras HN Lempira  HNL

es Mexico MX Peso  MXP

es Nicaragua NI Cordoba Oro  NIO

es Panama PA Balboa  PAB

es Peru PE Nuevo Sol  PEN

es Paraguay PY Guarani  PYG

es El Salvador SV Colon  SVC

es Puerto Rico PR US Dollar  USD

es Uruguay UY Peso  UYU

es Venezuela VE Bolivar  VEB

Swedish sv Sweden SE Krona  SEK

Thai th Thailand TH Baht  THB

Turkish tr Turkey TR Lira  TRL

Ukrainian uk Ukraine UA Hryvnia  UAH

Language
Language 
Code Country

Country 
Code Currency

Currency 
Code
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Chapter 4
User Administration
With Get.It! Base, user administration can be almost completely automated. If 
you are using Get.It! Base with AssetCenter or ServiceCenter, the systems can 
be set up so that users can register themselves and log in using any name cur-
rently registered in either AssetCenter or ServiceCenter. 

User Registration
The Get.It! Base weblication has been designed so that users can register on-
line, eliminating the need for a system administrator to respond to every 
request for access. 

The basic information and login scripts are stored in the .../getit/apps/
common/jscript/ directory. Basic registration and login scripts are in the file 
named login.js. If you want to make changes to the registration process, 
such as changing the way a user’s password is defined, you can change the 
scripts in this directory.

The users will be prompted for certain default information as shown in Figure 
4.1.
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If you are using AssetCenter, Get.It! Base will transform this data into a Pro-
file record that will then be passed to your AssetCenter system. An amEm-
plDept record is created with the user-supplied data and a default Profile will 
be assigned, getit.default.

If you are using ServiceCenter, you can set up your system to automatically 
create an operator record in ServiceCenter. Refer to your ServiceCenter docu-
mentation for information on creating user profiles and setting up capability 
words. A contact record is also created for the new user in ServiceCenter.

User Authentication
When a user attempts to log on to the weblication, the user name and pass-
word they enter are validated against the AssetCenter and ServiceCenter pro-
files. The name and password combination may be valid in none, one, or both 
of the systems. If the entered combination is invalid or does not exist in any 
systems, the user will be prompted to enter a valid user name and password. 
If correct in both systems, the weblication will retrieve the access rights for 
the user and log the user into Get.It! Base. If the combination is valid in one 
but not both systems, the access rights defined in the profile where the user 
name and the user password are valid will be used.

Fig. 4.1 Registering a new user

The adapter must be 
defined before the 
capability words will 
be recognized. For 
example, if no 
adapter is defined 
for Service Center, 
the ServiceCenter 
capability words will 
not be used.
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You can also remove password authentication. The JavaScript that authenti-
cates user login is located in the ...\apps\common\jscript\login.js file. 
Located within this file you will find the login() function. Overriding this 
function will remove password authentication. 

Setting the User’s Language
When a user logs in using Get.It! Base, the login programs detect the pre-
ferred language set in the browser and determine if the user’s language is sup-
ported by Get.It! Base. If the language is supported, Get.It! Base will be 
displayed in that language.

If the language is not supported, the default language is used. The default lan-
guage is set in the Archway.ini file through the Locale field in the Adminis-
tration Module. The first entry in this field is the default language.

Note: The AssetCenter templates provided with Get.It! Base support English 
only.

To change the language you are using with Get.It! Base, do the following:

1. Open the Admin>Settings page.

2. In the Locales field, type the two-letter designation of the language you 
want to use. Refer to the “ISO Chart for Locale and Currency” in Chapter 
3 for a list of language codes. Check the Get.It! Base release notes for the 
supported languages.

Note: If you would like a drop-down list from which users can choose the 
language they want to use, include English (en) in your list of 
languages in the Locales field. Include all languages in this field, 
separated by commas. Figure 4.2 shows settings for English, French, 
German, and Italian locales.
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3. Scroll to the bottom of the Settings page and click Save. Exit Get.It! Base.

4. Right-click the JRun icon on your Windows task bar. Click Stop to shut 
down JRun.

5. Open a command prompt and change directories to the ...getit\bin 
directory. Type wbuild getit, and then press ENTER.

6. When wbuild is finished, select Start>Programs>JRun>Start JRun (NT 
Service Mode) to restart JRun.

7. Log back in to Get.It! Base.

If you have set just one language in the Locales field, all window content 
will be displayed in that language. 

If you have set multiple languages, the login screen will be displayed in 
English with a language field and a drop-down list from which the user 
can select a language, as shown in Figure 4.3. However, if the back-end 
system is set up to use a different language than Get.It! Base, data from 
that system will be shown in the language supplied by that system. 

Fig. 4.2 Admin Settings—Locales
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All dates and currency are displayed and edited in the user’s language. The 
formatting is done when the weblication <field> or <input> tags have a type 
attribute equal to “date” or “currency.” Calendars display the translated week-
day name and start the week on the user locale’s first day of the week. 

Currency is displayed using the correct symbol and decimal indicator, how-
ever, the decimal point and the thousands separator are determined by the 
user’s preferred language and not the currency being displayed. For example, 
a French-speaking user will see US dollars as $1 234,00, a German-speaking 
user will see $1.234,00, and an English-speaking user will see $1,234.00.

If you have tailored Get.It! Base and want the tailored portions to display in a 
language other than English, you will need to follow the instructions in the 
“Localization Support” chapter of the Get.It! Base Tailoring Guide. 

Fig. 4.3 Language drop-down list
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Chapter 5
NT Challenge and Response
The NT Challenge and Response security feature is one of the ways NT facili-
tates the authentication of users on a Web server. The process consists of a 
secure handshake between the browser (IE) and the Web server (IIS). The 
handshake lets the Web server know exactly who the user is, based on how 
they logged on to their workstation. This allows the Web server to restrict 
access to files or application based on who the user is. Applications running on 
the Web server can use this information to identify the user without requiring 
them to log in.

Get.It! Base uses NT Challenge and Response as follows:

• The user logs on to an NT workstation.

• The user starts an IE browser and navigates to the Get.It! Base Login.asp 
page.

• IE automatically sends user authentication information to IIS. The user’s 
password is not transferred, but the NT Challenge and Response 
handshake between IE and IIS is enough for the server to recognize the 
user.

• The Get.It! Base login automatically detects the user by using the NT 
Challenge and Response/IIS server data.

• Get.It! Base logs in the user without requiring that a name and password 
be entered.

During this process, Archway authenticates and impersonates the NT user 
with each of its adapters.

Thes following circumstances must be handled during this process:

• The NT user is not yet registered with an Archway Adapter. When this 
occurs, Get.It! Base asks the user to register and enter profile information. 
Get.It! Base then lets the user log in and stores this information for future 
login attempts. 

• The NT user name is already registered as an Administrator in 
AssetCenter or ServiceCenter. When this occurs, Get.It! Base does not 
proceed with automatic login. The user is presented with another login 
screen and is asked to verify their password. This step is an added security 
measure to prevent a user from accidentally logging in with administrative 
rights. 
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Setting Up NT Challenge 
and Response

1. Open the IIS Management Console.

2. Click on the getit virtual directory.

Fig. 5.1 Updating the login.asp 
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3. Right-click on login.asp and select Properties.

4. Select the File Security tab.

5. Click Edit in the “Anonymous Access and Authentication Control” section.

6. Check Windows NT Challenge/Response. Make sure this is the only 
option checked. Click OK.

7. Click OK on the other windows displayed until you return to the Microsoft 
Management Console (shown in Figure 5.1).

Updating the loginverify.asp File

1. Repeat the steps above for loginverify.asp. Follow steps 3 through 5 as 
they are written above except select loginverify.asp instead of 
login.asp.

2. In the Authentication Method window, check the Allow Anonymous 
Access and Windows NT Challenge/Response options. Click OK.

Fig. 5.2 Setting Authentication for login.asp
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3. Click OK on the other windows until you return to the Microsoft 
Management Console (shown in Figure 5.1).

Fig. 5.3 Setting Authentication for loginverify.asp
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Setting Permissions for the Presentation Folder

1. Use the Windows NT Explorer to navigate to the ...getit/presentation 
folder.

2. Right-click on presentation/ and select Properties.

3. Under the Security tab, click Permissions. 

Note: If you do not see a Security tab, verify that Get.It! Base is installed on 
an NTFS partition.

Fig. 5.4 Locating the presentation folder
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4. Click Add to change the user groups that have permission to access the 
folder. Change the permission to a named authenticated group. For 
example, you could change permissions to all “Authenticated Users.”

5. If the user group called “Everyone” has permissions, highlight the entry 
then click Remove so that only the group you selected in the previous 
step can access Get.It! Base.

6. Click OK. Close all remaining windows.

Testing the Settings

Log into Get.It! Base to make sure the access permissions are set correctly. 
The NT Challenge and Response settings are activated when you log into 
Get.It! Base through a special login page named login.asp. Accessing Get.It! 
Base through the standard login.htm page results in the users needing to 
login as usual. 

1. Open a Web browser.

2. Enter the following URL: http://webserver/getit/login.asp in the 
browser address field (replace webserver with the name of your Web server 
and getit with the virtual directory name).

3. Verify that access to Get.It! Base is what you expected based on the 
settings you chose for the login.asp and loginverify.asp files. 

Fig. 5.5 Giving permission to authenticated users
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Setting the Default Login as login.asp

You can set the default login within Get.It! Base to use the NT Challenge and 
Response settings. 

1. Open the login.htm file in the ...getit/presentation/ directory.

2. Locate the following:

function onPageLoad()
{
  top.location.replace( "login.jsp" );
}
</script>

<body onLoad="return onPageLoad();">

3. Change login.jsp to login.asp.

4. Save your changes. 
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Chapter 6
File Attachment
Overview
Get.It! Base provides functionality that allows users to attach files (for exam-
ple, a Microsoft Excel or Word file) to Get.It! Base Web pages, for example, a 
problem ticket or request for equipment, to provide additional information.

HTML supports a field that allows the user to select a local file and upload the 
file to the server. By implementing this functionality, Get.It! Base provides 
support for gathering more data for server requests that internal personnel 
can then view through the back-end clients.

There are three parts to File Attachment usage within Get.It! Base: 

• Uploading a file to the Web server 

• Attaching the file to the appropriate back-end record 

• Displaying information about a file or the file itself within the Get.It! Base 
form

This chapter is divided into two sections:

• Administrator Procedures—includes File Attachment setup and security 
considerations, and information about the XML calls that provide the user 
functionality described in the User Procedures section.

• User Procedures—includes a sample Web page with instructions for 
uploading a file and for displaying existing file attachment information in a 
Web browser.

The file attachment 
function is available 
only if you are using 
ServiceCenter or 
AssetCenter for your 
back-end system.
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Administrator Procedures
The system default is to store attached files in the \presentation\attach-
ments directory. However, this can open your system to possible security vul-
nerability. As a safeguard to your system, it is recommended that you create a 
virtual directory at the root level that references the attachment directory. You 
will also need to update the archway.ini file to include information about the 
virtual directory.

Adding the Attachments Virtual Directory 

The procedure below uses Internet Information Services (IIS) as an example 
of creating a virtual directory. 

1. Create a directory at root level called attachments (c:\attachments).

2. Delete the getit\attachments folder.

3. Open IIS.

4. Right-click on your default Web site, and then choose New -> Virtual 
Directory.

5. Click Next.

The Virtual Directory Alias dialog box is displayed.

Fig. 6.1 Internet Information Services
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6. Type “attachments” in the Alias field. Click Next.

The Web Site Content Directory dialog box is displayed.

Fig. 6.2 Virtual Directory Alias

Fig. 6.3 Web Site Content Directory
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7. In the Directory field, type “c:\attachments”, and then click Next.

The Access Permissions dialog box is displayed.

8. Select “Read” and “Write” permissions only. Click Next.

A new virtual directory, attachments, is created.

Continue to the following procedure to update the archway.ini file.

Updating the archway.ini File

After you have added the virtual directory, you will need to update the 
archway.ini file as follows:

1. Shut down JRun before you edit the INI file.

2. Open the archway.ini file and add the following parameters:

• attachvirpath=/attachments/

• attachserverpath=c:\attachments\

3. Save the file, and then restart JRun.

The following sections include configuration information. Refer to ”User Pro-
cedures” on page 3-9 for instructions on using the File Attachment function.

Fig. 6.4 Access Permissions
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Archway.ini Parameters

The File Attachments functionality uses defaults that can be overridden by 
the following parameters in the archway.ini file. These parameters allow you 
to set the paths for the file attachments and to establish a maximum allow-
able size for the attachment.

Attaching a File To a Record

After a file has been uploaded to the Web server, further processing is required 
to actually upload the file to the back-end server.

Security Considerations

Allowing the user to upload files to the Web server is accomplished by an XML 
line. The files are loaded into an attachments directory, separate from the 
presentation directory used by the other Get.It! pages. This allows you to 
choose whether to allow addition of attachments to a record automatically or 
to quarantine uploaded documents until they have been reviewed or scanned 
for viruses. 

A default HTML file is included in the \presentation\attachments directory 
to prevent directory browsing, again for security reasons to prevent users from 
viewing unneeded information on the server.

For automatic inclusion of a file into a record, modifications to the Jscript are 
required and should be placed after the call for creating or updating a new 
record. Code for doing this is included in the service.js file in the
service/jscript directory and is contained in the function newTicket() and 
the function updateTicket(). The function to make this call to file attach-
ments is located in the file common/jscripts/fileattachment.js.

Parameter Description

attachvirpath Sets the Web directory reference from which files 
will be drawn for viewing. The default is /getit/
attachments/ if not set in the archway.ini file.

attachserverpath Sets the physical path on the Web server where 
the files will be stored. The default is <getit 
home>\presentation\attachments\ if not set in 
the archway.ini file.

attachmaxsize Establishes the maximum size in KB for an 
attached file. The default is 2048 KB (2 MB).
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Uploading the Document to the Database

After a message has been built and then sent to Archway via the sendDocIn-
sert, the function fileattachment.attachfiles is called. The calling sequence 
is:

fileattachment.attachfiles( adapter type, schema, recordid, files);

Below is sample code showing how to do the file upload for ServiceCenter.

function updateTicket( msg )
{
  var msgTicket = new Message( "Problem" );
  msgTicket.set( "Description",  msg.get( "newupdate" ) );
  msgTicket.set( "ID", msg.get( "Id" ) );

  archway.sendDocUpdate( "sc", msgTicket );

fileattachment.attachFiles( "sc", msgTicket.getDocument () 
.getTagName(), msgTicket.get( "Id" ), msg.get( "FileName" ))

return msgTicket;

}

msgTicket.getDocument() .getTagName()—gets the value for the 
schema based on the XML document defined when creating msgTicket.

msgTicket.get( "Id" )—returns the identifier for which ticket should be 
updated in ServiceCenter.

msg.get( "FileName" )—gathers the list of file names stored in the form 
field specified in the XLM.

Parameter Description

adapter type Defines which back end systems the files should be uploaded 
to. ServiceCenter and AssetCenter are supported. For the 
adapter type, type “sc” for ServiceCenter or “ac” for 
AssetCenter.

schema name The name of the schema that is used to define the database 
table properties.

recordid The unique identifier for the record being uploaded.

files A list of the files that were uploaded.
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XML Calls

When a user uploads a file to the Web server or requests that information 
from a file be displayed in the Web browser, the process is accomplished 
through an XML call. The following section describes these calls. See “User 
Procedures” on page 6-9 for the user instructions for performing these tasks.

Uploading and Displaying a File

A weblication defines the upload and view file attachments functions as fol-
lows:

<input label=”labelname” type=”attachments” record=”record name” 
adapter=”adapter type” field=”fieldname” add=”true/false” 
view=”true/false” submitonly=”true/false” id=”record id”  
colspan=”4”/>

Example:

<input label=”File Attachments” type=”attachments” record=”Problem” 
adapter=”sc” field=”FileName” colspan=”4”/>

Attribute Description

label The title which will appear next to the select box. In 
this example, File Attachments will appear next to 
the select/combo box.

type The type of input field being set, in this case, the 
type is attachments.

record The table name in the back-end database which is to 
be updated.

adapter The adapter to be used to communicate with the 
back-end database

field The name for the HTML field that is updated in the 
screen. This does not have to correspond to a field in 
the database records, although it can.

add If this attribute is set to true, a user can upload 
files; if it is set to false, uploading is not allowed. 
The default is true.
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view If this attribute is set to true, the user can view an 
uploaded file through a browser window. The file 
will be viewed according to the default settings for 
that type of application within the browser. The 
default is true.

submitonly Not being used at this time. A placeholder for future 
implementation.

id The identifier for the record which is being updated 
with the file attachments in the back end.
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User Procedures
The following procedures explain how to use the File Attachment feature. The 
Web pages shown are examples using ServiceCenter problem tickets.

Uploading a File to the Web Server

You can use this function to attach a file to new or existing records in a back-
end database. 

Files uploaded to the Web server are placed in an attachments directory, a 
separate directory from the presentation directory used by the other Get.It! 
pages. This directory defaults to presentation/attachments.

The following procedure uses a problem ticket in ServiceCenter as an exam-
ple, but the procedures for attaching to forms using other databases would be 
similar.

1. With a problem ticket form displayed, click the add button (plus sign) in 
the “Add file attachments” section at the bottom of the form.

Add View

Fig. 6.5 File attachment 
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A dialog box is displayed in which you can enter the path to the file you 
want to attach.

2. Type the path to the file you want to attach. Or click Browse to select a 
file, and then click Open. 

3. Click OK in the Select a File dialog box. 

The file is added to the Attachments drop-down list.

Fig. 6.6 Dialog box for choosing a file to 
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Viewing an Attached File

Attached files can be viewed in a separate window that is accessed from the 
problem ticket. 

To display an attached file:

1. In the Attachments drop-down list, select the name of the file you want to 
view. 

2. Click the view button (magnifying glass).

The file is brought up in a separate browser window, according to the 
default settings for the browser. How the file is displayed will vary 
depending on your browser and how your individual machine is set up. 

In the following example, the .xls type of file is not set to be viewed 
automatically, so the user is given the choice to open the file or save it to 
disk. For files like .html, .jps, .gif, or other HTML-type files, the file will 
just open in the browser.

There must be an 
existing virtual directory 
with an alias of 
“attachments” in order 
for you to be able to 
display attachments. 
Refer to ”Administrator 
Procedures” on page 
3-2 for instructions.

Fig. 6.7 File Attachment drop-down list

View attachment

If the attachment is 
an executable (.exe) 
file, it is 
recommended that 
you save it to disk 
rather than opening 
it. You can then scan 
the file for viruses 
before opening it.
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3. To view the file, select “Open this file from its current location,” and then 
click OK.

The file is displayed in a separate window in the browser.

Fig. 6.8 File download options

Fig. 6.9 Viewing an attached file
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Chapter 7
Troubleshooting
This chapter includes information to help you validate connection with the 
Web server and troubleshooting tips for problems with virtual directories, IIS 
configuration, Apache and JRun, and portal display.

The chapter also includes a Frequently Asked Questions section.

Verifying Installation and Configuration

IIS Server

1. Open the IIS console.

2. Right-click on the server name (not the Web site), and select Properties 
from the drop down menu.

Fig. 7.1 Virtual directory properties
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3. From the Master Properties drop-down list, select WWW Service, and 
then click Edit.

Fig. 7.2 Editing properties

Fig. 7.3 Verifying filter installations
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4. Select the ISAPI Filter tab, and check filter installation.

5. Verify a green arrow appears next to the JRun filter name. This indicates 
the JRun Connector Filter has been installed.

6. Click OK.

Starting/Stopping IIS/PWS Service
Access the Windows NT services panel and select Services from the Control 
Panel window.

1. Select the IIS Admin Service, and click Stop/Start.

2. Click Yes at the next prompt if you are shutting down the service.

3. Stop/start the JRun service before clicking Close to exit the Services 
window.

Note: On Windows 2000 Server systems, the Services control panel is located 
in Programs > Administrative Tools.

Starting/Stopping JRun Service

To stop JRun, click the cog icon at the right side of your Windows Start menu. 
The JRun Application Manager window is displayed. Click Stop and wait for 
the window to close on its own. Then click Start>Programs>JRun>Start JRun 
(Application Mode). The JRun Application Manager window is displayed. Do 
not click any buttons. Let JRun start and then click Hide. 

Troubleshooting Tips
If you are experiencing unexpected results, refer to the log files located in the 
...JRun\jsm_default\logs folder.

The stdout.log produces useful information in debugging the installation 
and configuration. 
Troubleshooting 7-3



.

Error Codes

JSM001

The jsm.properties file installed with JRun must be enhanced for Get.It! 
Base. The installation and configuration process using the setup wizard 
should perform all the necessary modifications to this file.

In the event that you receive an error indicating error jsm001, use the settings 
in this section to manually modify the properties.

This file is located in the JRun\jsm-default\properties directory

Fig. 7.4 Checking JRun log files
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1. Open the jsm.properties file.

2. Identify the CLASSPATH string.

Fig. 7.5 The jsm.properties file

Fig. 7.6 Updating the classpath
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3. Add the following to the end of the java.classpath line.

C:/Program Files/getit/bin/activation.jar;C:/Program Files/getit/
bin/lotusxsl.jar;C:/Program Files/getit/bin/mail.jar;C:/Program 
Files/getit/bin/prgn.jar;C:/Program Files/getit/bin/xml4j.jar;C:/
Program Files/getit/bin/js.jar;C:/Program Files/getit/bin/
fesi.jar;C:/Program Files/getit/bin/;c:/Program Files/getit/bin/
jsse.jar;C;/Program Files/getit/bin/jnet.jar;C:/Program Files/
getit/bin/jcert.jar

Where C:/Program Files/getit/... represents the distribution path entered 
during the Get.It! Base installation and setup.

 The following CLASSPATH is an example:

4.  Save the new configuration.

Servlets001

If you encounter this error, the servlets.properties file needs to be modified.

1. Open the servlets.properties file, located at ...\JRun\jsm-
default\services\jse\properties\Servlets.properties

2. Add the following lines to the end of the file:

servlet.archway.code=com.peregrine.archway.Archway
servlet.archway.args=
servlet.archway.preload=true.

Fig. 7.7 The updated classpath
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The file should appear as shown in the figure below:

Frequently Asked Questions

Installation

Q.. What should I do if I receive errors during the Get.It! Base installation? 

A. Uninstall Get.It! Base and uninstall JRun. Verify that both applications are 
deleted as well as any remaining directories (consult the scripts directory 
{default is C:\Inetpub\scripts} and delete or move all remaining files). 
Reboot your PC, stop IIS, and reinstall Get.It! Base and JRun.

Fig. 7.8 The updated servlets.properties file
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IIS Configuration

Q. How do I verify the IIS Configuration?

A. Launch a Web browser and connect with the Web server by inserting the 
URL for the local webserver. Type one of the following three options for the 
URL: http://localhost (local machine), http://127.0.0.1 (IP address for 
local host), or http://machinename (replace machinename with the actual 
machine name).

Inserting any of these URLs should connect you with the default homepage for 
the Web server. If you successfully connect then the Web server is working cor-
rectly. If you are unable to connect with the default Web page then the prob-
lem is with the web server. 

Make sure that you have a virtual directory for Get.It! Base on the Web server. 
Display the IIS console and click on the Web site where Get.It! Base is 
installed. Verify that a directory named getit exists. You may see more than 
one getit virtual directory. The format will be getit_vm(n) where (n) is a 
sequential number that you assign. If there is not a getit directory, then you 
need to create one that points to ...getit\presentation, where Get.It!Base is 
installed. See Chapter 2, "Windows NT Installation Procedures." for instruc-
tions. If a getit directory exists, right-click it and select Properties. Verify 
that all Properties are selected, such as Write Access, Script Execute. Also 
verify that Access Permission are selected for both Read and Write capability.

Using a browser, connect to the Get.It! Base login application (e.g., http://
localhost/getit/login.jsp).

If you can access the Web server using the method in the first step, but cannot 
connect with the Get.It! Base directory in this step, there is a problem with 
the virtual directory configuration. Verify its creation and settings based upon 
the recommendations defined in Chapter 2, "Windows NT Installation Proce-
dures."

If you see JSP code in the browser, JRun is incorrectly installed. Uninstall and 
reinstall Get.It! Base; this will reinstall JRun.

The browser may display the subdirectory and all JSP files. This means that 
the initial IIS configuration is incorrect. Use the IIS console to locate the 
getit virtual directory, right-click on the directory name, and select Proper-
ties. Examine the default document setting in the “Documents” tab. Make 
sure that you have the following entries: Default.htm, Default.asp,  
Default.asp, and Login.jsp.
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Internal Server Error Messages 

Q. What should I do if I receive an internal server error while running Get.It! 
Base?

A. There is an error in the JSP file that you are accessing.. You must delete all 
compiled objects and then recompile with JRun. First, use Windows NT 
Explorer to locate the ...\jrun\jsm-default\services\jse\serv-
lets\jsp\getit\ directory. Delete all files within this directory and then 
delete all JSP files from the ...\getit\presentation\ directory. Display a 
Command Prompt (Start > Programs > Command Prompt). Change the direc-
tory to C:\Program Files\getit\bin. You should see C:\> as your prompt. 
Type cd program files\getit\bin and press ENTER. Type wbuild getit at 
the prompt and press ENTER (this command lists all processing it is going 
through). Log into Get.It! Base. 

JRun 

Q. How do I verify the JRun Connector Filter? 

A. Verify that the Web server is correctly configured for all ISAPI filters. The 
most important filter is the JRun Connector Filter. To verify this filter, open 
the IIS Console, right-click on the Web server icon within the console, and 
select Properties. Click Edit, and then click ISAPI Filters. Verify that the 
Status column has a green arrow pointing up for all filters, the most impor-
tant being the JRun filter. If you have configured multiple VMs, you will not 
have this filter.

If you see the error “Could not connect to the JRun Connector proxy” when 
accessing login.jsp, start the JRun server. You can either do this from Con-
trol Panel > Services or from Start > Programs > JRun menu.

Q. Do I have to restart JRun each time that I create a modification in 
Get.It! Base?

A. In a development environment, set debugscript to true. Each time that you 
create a modification to JScript, the change will automatically occur when the 
script is executed. Without this setting turned on you will have to restart 
JRun each time a modification is made to the JScript. Do not leave this setting 
turned on (set to true) in a production environment, due to overhead.
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Apache/JRun 

Q. Get.It! Base is installed on an Apache web server with JRun., but the 
Get.It! Base screens do not display. How do I correct this?

A. JRun may be running incorrectly. If the text of the JSP files can be dis-
played, either JRun is not running or Apache is not loading the JRun module 
correctly. Consult the README.apache file located within the JRun directory for 
instructions on setting up JRun to work with Apache. This may involve 
installing a 1.3.4 version or greater release of Apache and then recompiling 
the Apache web server on your platform. Test the JRun installation by making 
use of the sample JSP files in the JRun directory or by using the sample JSP 
file located in the ...\jrun\contrib\jspc\hello.jsp directory. Copy a file to 
the Apache directory and then display it in a browser. If “Hello World” dis-
plays in the browser, JRun is working. If the text of the file displays then 
JRun is not working and the README.apache document should be reviewed. 

It may also be that Apache is configured incorrectly. If Apache is incorrectly 
configured, the message “Internal Server Error” or “Directory or file not 
found” appears. Add the following lines to httpd.conf to configure the presen-
tation directory:

Alias /getit/ “/usr/local/getit/presentation/”
<Directory “/usr/local/getit”>
Options Indexes MultiViews
AllowOverride None
Options ExecCGI
Order allow,deny
Allow from all

</Directory>

Using a ScriptAlias directive does not solve the problem and generates the 
“Internal Server Error” when JSP pages are called. If no Alias is established, 
the “Directory or file not found” error is displayed in the browser. The Direc-
tory directive section specifies that those files within the presentation direc-
tory should be allowed to execute and that other files, such as graphics, are 
viewable and therefore not executable. Without this option, JSP files will not 
execute when called.

Verify that the JRun installer added JRun settings to the end of Apache’s 
httpd.conf. If not, reinstall JRun. Finally, verify that JRun’s LoadModule live 
in httpd.conf is not commented out with a hash (#).
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Get.It! Base

Q. Where should my Get.It! Base user modifications go?

A. Application or form user modifications should reside in the 
...getit\apps\user\weblication directory. JScript user modifications reside 
in the ...getit\apps\user\jscript directory. Schema user modifications 
reside in the ...getit\apps\user\schema directory. 

Q. Can I remove password authentication in Get.It! Base?

A. Yes. The JavaScript that authenticates user login is located in the 
...\apps\common\jscript\login.js file. Located within this file you will find 
the login() function. Overriding this function will remove password authenti-
cation. 

Q. Can I access any screen within Get.It! Base from any page on the Web?

A. Yes. When wbuild is run, each JSP page that is created in the 
...getit\presentation directory contains code to check if the user is already 
logged in or requires a login to Get.It! Base. This means that you can move to 
any form in Get.it! Base and authentication will be performed. To access a 
Get.It! Base screen from an HTML page, find the JSP page you want to link 
to. It will reside in the ...getit\presentation directory. Then use the <a> 
tag to link to the page. For example:

<html>
<ahref=”http://localhost/getit/
e_service_report_describe.jsp?Category=software&Priority=high">Ope
n a Problem</a>
</html>

Q. What debugging facilities are available in Get.It! Base?

A. Log in as an administrator in Get.It! Base and modify the Administration 
Module Settings. Ensure that logfile is set to a valid location and make sure 
that debuglog and debugscript are set to true. These settings are stored 
within ...getit\bin\archway.ini. Any call via archway will then be logged. 
You can also write to the logs from JScript using the env.debuglog statement 
as shown below.

env.debuglog("### Here are the contents of msgResult " + 
msgResult.getContent() ); 

Do not leave debuglog and debugscript set to true once you are in a pro-
duction environment unless absolutely necessary for debugging pur-
poses.
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Q. Sections of different forms in my Get.It! Base application are identical. Is 
this code redundant?

A. The <component> tag will help you to create a common section of XML. The 
following is an example of a <component> called detail.

<components>
  <component name="detail">
    <fieldtable>
      <row>
    <field label="Status" field="Status"/>
    <field label="Ticket number" field="Id"/>
      </row>
....
    <fields>
      <input type="hidden" field="Id" value="$$(Id)"/>
      <input type="hidden" field="Status" value="$$(Status)"/>
    </fields>
  </component>
</components>

Now you can reference the common section of xml code using the components 
tag within a form as follows:

<form.......>
........
<component name="detail"/>
.......
</form>

Q. What is the form stats display?

A. The form stats display is a useful method of determining the location of a 
form within an activity and module in the apps directory. To turn on the form 
stats display, you must log in to Get.It! Base as an Administrator and then 
modify the Setting displayforminfo to true. The current module, activity, and 
form will be displayed in the left sidebar when accessing Get.It! Base screens.

Q. How can I modify the size of a font on the Get.It! Base screens?

A. You must modify the ...getit\presentation\css\blues.css file. If you 
are using Netscape Navigator as your browser, modify the file in 
...getit\presentation\ns_css\blues.css.
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Portal

Q. I am using ServiceCenter for the Portal back-end system. When I run Get.It! 
Base , I don’t see the portal. How do I get the portal?

A. After installing Get.It! Base, restart both Archway and ServiceCenter. If 
you have not restarted both of these applications, this may explain the 
absence of the portal. If you install or update a version of Get.It! Base, there 
are several possibilities that may explain this inability to view the portal. One 
possibility is that the portal.inl file may be missing if you are using the SC 
Adapter as your Portal back-end system. 

To fix this, import this file by selecting Start > Programs > ServiceCenter and 
open the ServiceCenter console. Then click Start. Next, click Start > Pro-
grams > ServiceCenter > ServiceCenter Client. Log in as an Administrator. 
Click the Toolkit tab and then Database Manager. Select Options > Import/
Load. Insert .../getit/config/ServiceCenter/portal.unl in File Name and 
then click Load fg. 

Also verify that your user has the getit.portal access right, either in the 
default access right list in the Get.It! Base Admin Settings or in the user’s 
ServiceCenter or AssetCenter profile.

Scripting

Q. How can I embed HTML code that contains JavaScript in a Get.It! Base 
XML form tag?

A. If your embedded HTML code contains JavaScript, you may want to use 
JScript to build both the JavaScript and HTML. You must first create your 
HTML tags in the weblication form and then reference a variable. For 
instance,

<form name="start" onload="service.buildhtm">
.....
<html>
$$(Stuff)
</html>
.....

Now you build the Stuff variable in the JScript that is referenced in the 
onload parameter of the form—in this case service.buildhtm.

var Stuff="<!-- JavaScript code and Level 1 menu -->";
Stuff+="<script language=’JavaScript’>";
Stuff+="function findObj(n, d) {";
.....
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Stuff+="</script>";
Stuff+="<table align=’left’ CELLSPACING=’3’ CELLPADDING=’3’ 
WIDTH=’200’>";
....
msg.add ( "Stuff", Stuff );
return msg;

You may want to add a debug statement to see what your HTML code looks 
like:

env.debuglog("#### This is the html code " + Stuff );

Q. Can I call external servlets from Get.It! Base?

A. Yes. The following is an example of JScript that calls an external servlet 
and then passes that servlet a field called “Id” as a parameter. The servlet 
returns a message in an XML document format.

msgReturn = archway.sendHTTP( "http://something.something.com:1888/
servlet/servlets.GetitTest?testparam="+id, null );
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Q. Can I call an HTTP page from Get.It! Base?

A. Yes. This example shows how to add a button to a form that links to an 
HTML page that provides Help.

<actions target-form="example">
<submit> Refresh List </submit>
<home> Home </home>
<link target-url="http://someplace.around.com/help101.html" 
window="true"> Help </link>
</actions>

Q. How are client-side JavaScript and Java Applets viewed in unsupporting 
browsers?

A. Because Get.It! Base utilizes client-side JavaScript, numerous screens will 
not work properly in an unsupported browser. Get.It! Base uses one Java 
applet that displays workflow and one for Portal Help. If you are using an 
unsupported browser, you will not see these applets.

Performance

Q: How are the database connections pooled? 

A: When you install Get.It! Base, you can configure your system to run on var-
ious, simultaneous Java Virtual Machines. Each machine runs parallel but 
separate processes and maintains its own database connection. This may be 
useful when running on multiprocessor machines.

Q: Does Get.It! Base interface with NT Authentication for application sign on?

A: We fully support NT Authentication based on the NT Challenge and 
Response mechanism.

Q. How can I troubleshoot performance issues with Get.It! Base?

A. To troubleshoot system performance issues complete the following steps: 

1. Determine whether there are any queries continually running that are 
trying to access many records. For example, you should check in the logs to 
see if there are queries with no where clauses. This can cause the system 
to loop, which will use memory and cause unpredictable behavior.

2. Check the Administration Module Settings to ensure the “DebugScript” 
field is equal to false.  

3. Determine the number of ScriptRunners being created. The logs will 
indicate each time a ScriptRunner is created. Look for the lines that say:  
“Added ScriptRunner to Pool” and count the number of times you see this. 
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Check the maximum number of ScriptRunners allowed in the 
Administration Module Settings “MaxScriptRunners” field. It should be 
set to no higher than 10. 

4. Ensure any screens you have designed have clean onload scripts that do 
not pull in too much data. Remove combo boxes that display many options, 
converting them to searchable, popup fields. 

Browser

Q. Does Get.It! Base work on a Netscape server and Netscape browser?

A. Yes. 

Q. How can I access cookies from Get.It! Base?

A. The following is the syntax for accessing cookies:

id = user.getCookie(“CookieName”);

wbuild

Q. When should I use wbuild?

A. You need to run wbuild each time that you modify XML pages. For instance, 
you must run wbuild when you change a form in the ...getit\apps directory 
or when you modify a schema in the ...getit\apps\module\schema (where 
module is the name of the module, such as assets). wbuild rebuilds JSP pages 
in the ...getit\presentation directory.

AssetCenter

Q. What should I do if I cannot pull data from AssetCenter?

A. There is an AssetCenter connectivity problem. Log into Get.It! Base as an 
Administrator and access the Get.It! Base Admin module. The Control Panel 
window is displayed. Check the connection status of Get.It Base to Asset-
Center to see if it says “connected” or “disconnected.”

If the status is “disconnected” reset the server by clicking Reset Server. If 
this does not change the status to “connected,” then continue with the follow-
ing. 
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Click Settings (this accesses the archway.ini file). Scroll down to see the 
AssetCenter Adapter Settings. Verify the “Database” field is pointing to the 
correct database, by default this field is set to ACDemo351ENG. Also make 
sure the Administrator and Anonymous password fields have not been edited 
in the Admin module since these fields are encrypted. 

Log into the AssetCenter database on the AssetCenter server. Make sure the 
login account referenced in the Get.It! settings matches the login for Asset-
Center. Check the ODBC connection. Depending on the way you run JRun, it 
will look for a User DSN or a System DSN. If you start JRun as an application, 
it will reference the User DSN for the ODBC connection to the database. If 
you start JRun as a service, it will reference the System DSN for the ODBC 
connection. While logged into AssetCenter, use the File menu to access the 
Manage Connections option. Verify that the user name and password are cor-
rect for the connection.

Q. Get.It! Base does not appear to recognize AssetCenter default script function-
ality. How do I correct this?

A. Make sure you have the appropriate user rights in the AssetCenter profile. 
If you change default scripts in AssetCenter make sure that you save your 
changes by disconnecting from the database or through the tools\adminis-
tration .../save the database configuration menu entry. Restart JRun 
and then reconnect.

Q. When I call Get.It! Base from a client or a Web server I receive an error: 
“Unable to connect to AC: Connection ‘acdemo351eng’ unknown in ‘amdb.ini’.” 
error. Is this problem correctable?

A. Yes. This message occurs because there is no amdb.ini file. This means that 
you can’t log in becasue there is no system to identify the user. If you have 
another system doing the user identification (such as ServiceCenter), you will 
be able to log in, but you won’t be able to work with any of the applications 
supported by AssetCenter.

To correct this problem:

Check if AssetCenter is installed on the same machine as Get.It! Base. If it is 
not, install AssetCenter with the APIs (available only through a Custom or a 
Full installation). If AssetCenter is installed, or you have just installed it, con-
nect to the database you will access with Get.It! Base; it will set up the 
amdb.ini properly. Be sure that the AssetCenter database you want to access 
is the one you refer to in the Admin settings screen. Restart JRun. This error 
will be gone.
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Q. I have Get.It! Base connected with Oracle, but it doesn’t seem to be talking 
with the database.

A. Add the following line to the SQL section of the aamapi30.ini file, located 
within the WINNT directory:

OracleDLL=oraclient8.dll

Error Codes

Q. Why do I receive the “XSL warning: Could not find macro def named: outpu-
tUserFields” error message?

A. You will receive this message if a weblication <input> element either lacks 
a type attribute or has an unsupported type value. 

For example, if the following line is in an XML file, it will generate the error 
because it lacks a type attribute:

<input label="Number to order"  field="nCount" /> 

To correct the above line, enter the following instead:

<input label="Number to order"  type="text" field="nCount" /> 

Firewalls

Q. Can users outside of the company firewall access Get.It! Base?

A. Get.It! Base has no firewall issues. If the user can access internal servers, 
they can access Get.It! Base. 
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